# Contents

1. **Overview** ......................................................................................................................... 3  
   - What is Monodraught HTM®? ..................................................................................... 3  
   - Requirements for using HTM in the Virtual Environment ........................................... 3  

2. **HTM Background** ........................................................................................................... 4  
   - What is the Priority School Building Programme and design requirements? ............ 4  
   - Why Choose Hybrid Thermal Mixing? ........................................................................ 5  
   - HTM Key Features ......................................................................................................... 5  
     - HTM F – Key Features ......................................................................................... 5  
     - HTM FS - Key Features ..................................................................................... 6  
   - Typical Installation - Operation Detail ........................................................................ 7  
     - Cross Flow .......................................................................................................... 7  
     - Single Sided Flow ............................................................................................... 7  
     - Additional Ventilation ......................................................................................... 7  
     - Control Strategy ................................................................................................... 7  
     - Controls and user interface .................................................................................. 8  
     - HTM Case Study: Thomas Hickman School ........................................................ 8  
     - Further Information .............................................................................................. 8  

3. **Using HTM in the VE** .................................................................................................... 9  
   - Introduction ............................................................................................................... 9  
   - Importing the HTM units ............................................................................................ 10  
   - Using the HTM Grouping Scheme ............................................................................ 11  
     - Duplicating Unit Groups ..................................................................................... 11  
     - Deleting Unit Groups ......................................................................................... 11  
     - Editing Unit Group Properties ............................................................................ 12  
   - Assigning HTM to Rooms ......................................................................................... 14  
     - Assignment Guidance .......................................................................................... 14  
     - HTM Assignment .................................................................................................. 15  
     - What happens when a room is assigned? ............................................................. 16  
     - What happens when a room is unassigned? ......................................................... 17  
   - Editing HTM Opening Types ...................................................................................... 17  
     - Changing Opening Type on the view ................................................................... 17  
     - Changing Opening Type using the browser ......................................................... 18  
     - Changing Opening Type using *Opening Selection and Assignment* .................. 19
Opening Type Updates..............................................................20
Simulating with HTM ................................................................21
Applying HTM to an ApacheHVAC system file............................22
Simulate HTM performance using Apache.................................23
4. HTM and UK NCM analysis (Part L & EPCs)..........................24
   The NCM framework ..........................................................24
   Analysing the real building and the Actual Building...............24
Appendix A: Frequenty Asked Questions ..................................27
Appendix B: HTM Technical Data..............................................29
   Louvre sizes and requirements for HTM systems....................29
   Recommended HTM system room configuration....................29
Appendix C: About Monodraught Ltd........................................30
1. Overview

What is Monodraught HTM®?
Following the release of the Facilities Output Specification (FOS) for the Priority Schools Building Programme (PSBP), Monodraught Ltd. have utilised their extensive knowledge, product testing, and building simulation skills to develop low energy ventilation systems which meet the FOS requirements in a cost-efficient manner.

The Hybrid Thermal Mixing (HTM) system from Monodraught is designed to provide natural ventilation and hybrid ventilation incorporating mixed tempered air for winter periods, with the ability to provide secure night time cooling and boosted levels of ventilation during summer. The system is designed to work in conjunction with other natural ventilation provided by manual or automatic windows or louvres and can be used in single sided or cross flow ventilation strategies. The units can be mounted horizontally above windows or mounted vertically to the sides of rooms and can also be ducted to provide ventilation to deep plan rooms.

The system comprises of an intelligent and fully automatic control system coupled with a low energy ventilation system which switches between operational modes dependant on season, external/internal temperature conditions and indoor air quality (IAQ).

The HTM systems have exceptionally low specific fan powers and feature an intelligent control system, which is supplied as standard, with full data logging facility, temperature control and CO2 control. With the optional BACnet module, each unit has the ability to output key performance data to a central BMS.

Further details on the units, control strategies and technical data is provided in this user guide (see HTM Background and Appendix B: HTM Technical Data). For the latest details on the HTM product line or to discuss potential suitability for your project, please visit http://www.monodraught.com.

Requirements for using HTM in the Virtual Environment
The Virtual Environment (VE) software includes built-in support for simulating both HTM FS and HTM F units from Monodraught. However, in order to simulate you will need valid licenses for the following VE modules:

- ModellIT
- Apache
- MacroFlo
- SunCast
- ApacheSim

If you are missing one or more of these licenses, you will not be able to use the Monodraught HTM functionality within the VE. Please contact keys@iesve.com for queries or support with licensing issues.
2. HTM Background

What is the Priority School Building Programme and design requirements?
The Priority School Building Programme (PSBP) is a centrally managed programme set up to address the needs of the schools most in need of urgent repair. Through the programme, 261 schools will be rebuilt or have their condition needs met by the Education Funding Agency (EFA). All schools within the programme will be delivered by the end of 2017. In May 2014, the Government announced a further phase of school development, known as PSBP2, which is a five-year programme operating between 2015 to 2021 and will undertake major rebuilding and refurbishment projects in schools and sixth form colleges in the very worst condition.

The Facility Output Specification forms the basis for the design of the PSBP Schools and has become the definitive guide to school design. The performance standards stipulated in PSBP requires three criteria, taken together, to be used to assess the risk of overheating of the building in the UK, using the geographically closest CIBSE Design Summer Year (DSY) weather file. A room or building that fails any two of the three criteria is classed as overheating:

- **Criteria 1- Hours of Exceedance:** During the occupied hours of the non-heating season (1st May to 30th September), the predicted operative temperature should not exceed the maximum adaptive temperature by 1°C or more, for less than 40 hours.
- **Criteria 2- Daily Weighted Exceedance:** For the severity of overheating, which can be as important as its frequency, the weighted exceedance of the temperature rise and its duration should be less than or equal to 6 during any occupied day of the non-heating season.
- **Criteria 3- Upper Limit Temperature:** The absolute maximum daily operative temperature for a room, beyond which the level of overheating is unacceptable, should not be greater than or equal to 4°C, than the maximum adaptive temperature (Top – Tmax), at any time.

With regards to internal air quality, TM52 criteria specifies that for natural ventilation or hybrid systems operating in natural mode:

- In all teaching and learning spaces when measured at seated head height, during the continuous period between the start and finish of teaching on any day, the average CO2 concentration of carbon dioxide should not exceed 1500 ppm.
- The maximum CO2 concentration should not exceed 2000 parts per million (ppm) for more than 20 minutes each day.

For mechanical ventilation or hybrid systems operating in mechanical mode, TM52 criteria specifies that:

- In all teaching and learning spaces when measured at seated head height, during the continuous period between the start and finish of teaching on any day, the average CO2 concentration of carbon dioxide should not exceed 1000 ppm.
- The maximum CO2 concentration should not exceed 1500 parts per million (ppm) for more than 20 minutes each day.

In addition to the mechanical and natural ventilation:
At any occupied time, including teaching periods, the occupants should have the ability to lower the concentration of CO2 to 1000 ppm. The extreme maximum CO2 concentration of carbon dioxide should not exceed 5000 ppm during the teaching day.

Why Choose Hybrid Thermal Mixing?

Ideal Environment:

- The HTM is able to provide the ideal environment to school classrooms/areas.
- The HTM system is designed to provide mixed tempered air during winter, boosted levels of ventilation during summer and secure night time cooling.
- The HTM system works in conjunction with natural ventilation provided by manual or automatic windows/louvres.
- The HTM system can be used in single sided or cross flow ventilation strategies.

Exceptionally Low Power Consumption:

- The HTM system has an exceptionally low specific fan power.
- The HTM system comprises an intelligent and fully automatic control system coupled with a low energy ventilation system which switches between operational modes dependant on season, external/internal temperature conditions and indoor air quality (IAQ).
- The HTM control system is supplied as standard with full data logging facility, temperature and CO2 controls. With an optional BACnet module, each unit has the ability to output key performance data to a central BMS.

HTM Key Features

Two versions of Monodraught’s HTM system are available, the HTM F and the HTM FS. Each system (or pair of HTM FS systems) is able to produce 360 l/s of daytime ventilation and 530 l/s of night-time cooling. A powder coated steel frame makes the system robust and easy to install. This frame supports a body constructed from specialist acoustic panels which when combined with a low energy fan means that the systems maximum daytime operation sound level is under 35dB. The low leakage external damper is integrated within the system and has a high U-Value of 1.2Wm2K and when combined with the internal damper allows the system to supply tempered fresh air throughout the year. A combination of an intelligent controls system and sensors measuring the room, external and mixed air temperatures & CO2 levels allows the system to automatically control the internal environment. This control system can also be utilised for the operation of additional VENTSAIR facade systems and has a full data logging facility.

HTM F – Key Features

- Low energy 380mm dia. fan - Low Speed
- 1 unit per classroom – Preferred option
- 500 mm Depth with 100mm gap required from ceiling
- Producing 340 l/s in Boost Mode
- Does not require any ducting
- Non-vision high flow white linear angled grille
Full acoustic testing has been conducted at SRL (Sound Research Laboratories).

**Sound reduction Index Measurements:**

<table>
<thead>
<tr>
<th>Ventilation Rate</th>
<th>63 Hz</th>
<th>125 Hz</th>
<th>250 Hz</th>
<th>500 Hz</th>
<th>1000 Hz</th>
<th>2000 Hz</th>
<th>4000 Hz</th>
<th>8000 Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>300 l/s</td>
<td>53.4</td>
<td>52.6</td>
<td>50.4</td>
<td>43.5</td>
<td>36.7</td>
<td>31.0</td>
<td>24.7</td>
<td>24.7</td>
</tr>
</tbody>
</table>

Weighted Sound Reduction Index Rw (C:Ctr) = 31 dB

Tests were conducted with a standard 50 mm external louvre arrangement.

**HTM FS - Key Features**
- 2No. Units make up 1No. System
- 1No. System per classroom
- Above ceiling installation
- 300 mm depth (required void of 350 mm)
- Each Unit Producing 180 l/s in Boost Mode
- High Performance Low Energy 280mm dia. fan – Low Speed
- Spiral wound ducting into classroom with 4-way diffuser

Sound power levels of the HTM FS per unit at 32% fan speed:

<table>
<thead>
<tr>
<th>Ventilation Rate</th>
<th>63 Hz</th>
<th>125 Hz</th>
<th>250 Hz</th>
<th>500 Hz</th>
<th>1000 Hz</th>
<th>2000 Hz</th>
<th>4000 Hz</th>
<th>8000 Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>150 l/s</td>
<td>46</td>
<td>50.8</td>
<td>44.4</td>
<td>39.7</td>
<td>35.4</td>
<td>25.7</td>
<td>17.9</td>
<td>22.9</td>
</tr>
</tbody>
</table>
Typical Installation - Operation Detail

Cross Flow

Monodraught HTM system mounted at the rear of a room to assist with cross flow ventilation using openable windows on the facade. System automatically provides secure night time cooling through natural ventilation opening or fan assisted if required. Winter ventilation automatically modulates dampers to mix re-circulated air with external air to ensure optimum ventilation temperatures.

Single Sided Flow

Monodraught HTM system mounted on the facade (can be ducted to provide ventilation to the rear of deep plan rooms) to assist with single sided ventilation using openable windows. System automatically provides secure night time cooling through natural ventilation opening or fan assisted if required. Winter ventilation automatically modulates dampers to mix re-circulated air with external air to ensure optimum ventilation temperatures.

Additional Ventilation

Monodraught’s HTM is designed to work with and control a range of VENTSAIR Facade Ventilation System (VAF), as well as work in conjunction with other external openings such as windows.

The benefit of using VENTSAIR system is that they can be specified to suit different sized glazed frames or fitted with a flange to suit wall openings, as well provide controlled fresh air during the day and secure night time cooling. The HTM will automatically control the additional vents and the dampers can also be opened and closed manually via the systems control panel. These additional ventilation openings are often used in lieu of manual windows adding the benefit of secure night time cooling.

Control Strategy

The HTM incorporates a fully automatic control system based on a seasonal control strategy. The seasonal strategy is determined by time and date but is weather compensated to pick up unseasonal conditions. The system provides natural ventilation as the default method of ventilation indicating when manual windows or automatically opening dampers should be utilised to maximise IAQ and maintain comfort levels.

The control system incorporates a number of temperature sensors integral to the unit to monitor external temperature, mixed air temperature and supply air temperature. In addition, a wall mounted controller fitted with an internal temperature, CO2 sensor and user override are included.
as standard. Data is stored per minute on an integral data card for data analysis and compliance requirements.

**Controls and user interface**

Monodraught offer three wall controller options, each dependent on the room design and layout and the user’s requirements. One wall controller is required to be mounted within each room and will give the user certain functionality over the systems. Each controller houses temperature and CO2 sensors, with the exception of the Smart Screen Controller which requires a modular unit.

**Openable Window:** Allows the user to control the fan speed but will also indicate when they need to open windows to aid the system in providing ventilation.

**Louver Override:** Allows the user to not only control the fan speed of the units but also regulate the amount that the VENTSAIR Facade system opens by if fitted.

**HTM Case Study: Thomas Hickman School**

- System installed on 02/09/2014 and data logged until 02/03/2015
- Classroom is approximately 5 m x 9 m (area = 45 m2)
- Ceiling height 3.2 m (volume = 144 m3)
- East facing glazing approximately 7 m x 2 m which cannot be opened due to external noise
- Occupancy of 30 children and 2 adults

<table>
<thead>
<tr>
<th></th>
<th>Max</th>
<th>Min</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Temperature</td>
<td>23 °C</td>
<td>21 °C</td>
<td>22 °C</td>
</tr>
<tr>
<td>External Temperature</td>
<td>7 °C</td>
<td>0 °C</td>
<td>5 °C</td>
</tr>
<tr>
<td>Mixed Air Temperature</td>
<td>25 °C</td>
<td>15 °C</td>
<td>19 °C</td>
</tr>
<tr>
<td>CO₂</td>
<td>1780 ppm</td>
<td>435 ppm</td>
<td>1300 ppm</td>
</tr>
</tbody>
</table>

Results between 8:30 – 15:30

<table>
<thead>
<tr>
<th></th>
<th>Max</th>
<th>Min</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room Temperature</td>
<td>24 °C</td>
<td>21 °C</td>
<td>23 °C</td>
</tr>
<tr>
<td>External Temperature</td>
<td>17 °C</td>
<td>6 °C</td>
<td>13 °C</td>
</tr>
<tr>
<td>Mixed Air Temperature</td>
<td>24 °C</td>
<td>13 °C</td>
<td>20 °C</td>
</tr>
<tr>
<td>CO₂</td>
<td>1580 ppm</td>
<td>505 ppm</td>
<td>1145 ppm</td>
</tr>
</tbody>
</table>

Results between 8:30 – 15:30

**Further Information**

- [Hybrid Thermal Mixing Ventilation Systems Brochure](#)
- [HTM F Product Card](#)
- [HTM FS Product Card](#)
3. Using HTM in the VE

Introduction

The integration of the HTM system support into the VE provides a fast, streamlined and easy-to-use method of simulating the effect of HTM units within your VE building model. A dedicated Navigator is used to guide you through the step-by-step process, from importing the units into your model, configuring their operation, preparing and applying to rooms, thermal simulation and review of the results.

To get started, click on the dropdown list of available Navigators at the top of the Navigators pane (if the pane is not visible on the left side of the VE window, you can turn it on using the button on the application toolbar, or by selecting Navigator from the view menu). You will find a Monodraught HTM® entry listed under the Partners section.

When selected, the Monodraught HTM® navigator will be displayed. This is what you will use to go through the process of applying HTM to your building, simulating and analysing the results.

In order to start using the navigator, you will need to have a fully defined VE model already created and loaded. This model should contain valid geometry representing the building, and may also be set up with valid data (e.g. heating set-points, cooling set-points, Apache systems, internal gains, air exchanges, MacroFlo openings) already assigned to the rooms. As the assignment of HTM to rooms will make direct modifications to the assigned data, it is always recommended that you make a back-up of your model prior to commencing the HTM integration – this will allow you to have a baseline that you can easily revert back to in the event of any issues. You can do this by clicking the Make an archive of the current model before making changes item in the navigator, or by selecting the Current Project item from the File->Archive menu.

Once completed, you will be ready to start using with HTM in your building model.
Importing the HTM units

To get started with HTM, you will need to import the required unit(s) into your building model. The units are represented in the VE by components – when placed into a room, the room will automatically be updated to make use of the HTM unit. You can import the units by clicking on the *Import the required HTM® systems from library* item in the navigator – this will open the *Add Components From Library* window with the Monodraught HTM® library pre-selected:

There are two types of unit that you can import into the VE – HTM FS or HTM F+. Details on selecting which type of unit would be best suited for your usage are given in *HTM Background* or should be discussed with Monodraught (see Appendix C: About Monodraught Ltd. for contact details). You can review the overview of each unit by clicking on it – this will also allow you to download the product datasheet.

To import the units, click on the checkbox next to the type(s) you want, then click on the *Import Checked Components* button. This will then copy the relevant component(s) into your model’s component library, making them ready to be assigned to rooms. In addition to the unit(s) themselves, the first import of an HTM unit to the model will also import some ancillary data that can be used when setting up your room openings (louvres and windows) prior to assignment:

- **Standard MacroFlo opening types for louvres and windows**

  *Note: If you do not require the MacroFlo opening types, they can be manually removed from your model after import using standard MacroFlo functionality if you have not already assigned them to windows or doors in the model.*

- **Standard Monodraught Quantum Damper** construction for HTM louvres (this will be automatically applied when a door is set as an HTM louvre).

Once the units have been imported, you can close the *Add Components From Library* window by clicking on the *Close* button.
Using the HTM Grouping Scheme

Once you have imported one or both of the unit components from the library, a new Monodraught HTM® room grouping scheme will be created in your model and automatically selected in the room browser pane (if the pane is not visible at the bottom left of the VE window, you can display it using the button on the application toolbar, or by selecting Browser from the File->View menu).

The HTM grouping scheme is the mechanism used to assign an HTM unit to a room in the model. The scheme contains one or more unit groups representing each unit type you have in your model – this will initially be the unit(s) you imported using the previous navigator action. There is also a final unit group called No HTM Assigned – if a room is not being served by an HTM unit, it is contained in this group (initially, all rooms in the model will be in this group).

Duplicating Unit Groups

Since all rooms assigned to a particular unit group will share the same HTM properties (i.e. number of units in room, opening highlighting and so on), you may want to create one or more duplicates to allow the same basic type of unit (FS or F) to be used with different properties on each. To duplicate a group, right-click on it in the grouping scheme and select the Duplicate item – this will then create a new unit group below the right-clicked group that can be edited and assigned to independently.

Deleting Unit Groups

If you have unit groups that are no longer required, you can remove them to avoid clutter. To remove a unit group, right-click on it in the grouping scheme and select the Delete item.

If there are one or more rooms currently assigned to the unit group, they will need to be re-assigned before the group can be deleted. The software will prompt you to do this before you can proceed:
Clicking *Cancel* at this point will mean that the unit group is not deleted and the room(s) remain assigned to it. Clicking *OK* will re-assign the room(s) to the alternative unit group and then remove the unit group.

All unit groups can be deleted (excluding the *No HTM Assigned* group). Note that if the last “real” unit group is removed, the grouping scheme itself will be automatically removed and the following alert will be displayed:

The grouping scheme can be reinstated by importing one or both of the original components again.

**Editing Unit Group Properties**

You can view and edit the HTM properties for each unit group (excluding the *No HTM Assigned group*) by right-clicking on the group item and selecting *Properties*. This will display the *Component Properties* window, consisting of two tabs: *Monodraught HTM® Properties* and *Information*.

The *Monodraught HTM® Properties* tab allows you to control the basics of the unit group such as naming, whether possible louvres and windows should be automatically identified when a room is assigned to the group, whether it will highlight its assigned louvres and windows, and its colour (displayed next to it in the grouping scheme and used by opening highlighting and if the *By Room Group* option is selected in the *View->Colour* menu).
Name: Allows you to change the name of the unit group. Editing this name will also update the name of the associated component in the model’s component library.

# of Units: Determines the number of simulated HTM units that will be used in each room that is assigned to the unit group. Note that each assigned room must have an integrated louvre for each simulated unit (e.g. if the # of Units is 2, each assigned room must have 2 integrated louvres). Refer to Appendix B: for details of required louvre sizes for HTM systems and ideal quantities of HTM systems for different room types.

Colour: Displays the colour currently used by the unit group for highlighting (this colour is displayed next to each group in the Monodraught HTM® grouping scheme). Clicking on the colour will display the standard colour picker window, allowing this colour to be changed.

In-use: Indicates whether the unit group is in-use (has one or more rooms assigned to it) or not in use.

Automatically identify HTM® openings on room assignment (where possible): If active, the VE will attempt to automatically identify any wall-based external windows or doors that can be associated to the HTM units in the room at the point it is assigned to the unit group. Any external windows or doors in the room that are assigned a MacroFlo opening type that is not using the “off continuously” profile will be considered for use by the HTM unit and their MacroFlo updated appropriately.

For more details on assigning louvres and windows for HTM units, see the Assignment Guidance section.

Highlight HTM® openings on view: These options control whether rooms assigned to this unit group will highlight their attached louvre(s) and/or window(s). Louvres will be highlighted in full colour, while windows will be highlighted in a lightened version of the colour. Note that the opening highlighting is only displayed if the Monodraught HTM® grouping scheme is active in the room browser.

IMPORTANT: switching off highlighting does not stop the openings from being used by the HTM units – it is simply a visual cue to provide at-a-glance identification of which openings in a room are used by the HTM in that room.
Note that if there are already room(s) assigned to the unit group when you apply changes to one or more of these settings, the updates will be applied to all currently assigned rooms.

The navigator action *Adjust HTM® operating parameters for the imported systems (as necessary)* will simply cycle through all available unit groups, asking you whether you want to edit the properties or skip.

This is equivalent to right-clicking on each unit group in turn and clicking on *Properties*.

**Assigning HTM to Rooms**

With the appropriate unit group(s) set up and valid properties set (see previous section for details), the unit groups are ready to be assigned to room(s) in your model. The *Monodraught HTM®* navigator will attempt to guide you through the process of setting up rooms for HTM usage.

**Assignment Guidance**

In order to accurately simulate HTM performance, any room you want to assign to an HTM unit group must meet the following pre-requisites:

- **The room must have one HTM Integrated Louvre for each HTM unit in a room.** For example, if an HTM unit group defines the *Number Of Units* property as 2, the room must have two HTM Integrated Louvres. All HTM louvres are modelled using external doors.
- **Each HTM F integrated louvre should have a minimum size of 0.45m²** – the typical dimensions of a standard louvre are 900mm in width and 500mm in height.
- **Each HTM FS integrated louvre should have a minimum size of 0.27m²** – the typical dimensions of a standard louvre are 900mm in width and 300mm in height.

It is the user’s responsibility to model the louvres at an appropriate size and position to reflect real-world conditions.

If the *Automatically identify HTM® openings on room assignment* setting (see previous section for details) is active for the unit group and a room is assigned to that group, any wall-based external door in the room that is assigned a MacroFlo opening type using a *Degree of Opening profile* other than off continuously will be considered as being available to be used as an HTM integrated louvre. Note that only the required number of suitable external doors (i.e. the *# of Units* value from the unit group properties) will be automatically used – any additional doors will be left as-is. In addition to handling external doors, all wall-based external windows that are assigned a MacroFlo opening type
using a *Degree of Opening* profile **other than off continuously** will be automatically used as HTM Natural Vent. Windows.

You will generally set up your model in the normal way beforehand, ensuring that you have defined suitably sized (see the sizing guidance above) and positioned external doors and windows, and with sensible MacroFlo assignments applied. If you need to add on new doors or windows to rooms you are planning on using with HTM, you can use the standard *Add Door* and *Add Window* features in ModelIT – simply set a suitable width, height and base height and add the openings.

**HTM Assignment**

You designate a room to be served with HTM by assigning it to the appropriate unit group in the *Monodraught HTM®* navigator – this can be done by any of the standard methods (e.g. using the button above the room browser, or by using the *Room Groups* tab within Tabular Room Data in ModelIT).

Once a room is assigned to an active unit group (i.e. a group other than *No HTM Assigned*), the room will display a Monodraught logo in the viewport (as well as highlighting which of the openings are attached to the HTM within that room) whenever the *Monodraught HTM®* grouping scheme is active in the room browser. The logo will also display a small circle overlay at the bottom-right, indicating the number of HTM units being represented in that room:
If a problem is detected with the room set-up (e.g. there was no valid louvre to attach to the HTM unit), then an exclamation mark overlay will be displayed at the top-right of the Monodraught logo – if you hover over the exclamation mark with the select tool (Ι) active, a balloon tip will be displayed to indicate the problem with the room. For example:

To correct this scenario, you must set the appropriate number of external doors to act as HTM Integrated Louvres. You can either:

- Edit the opening types of some of the doors in the room (see Editing HTM Opening Types), or:
- Use the Ensure that all rooms assigned to HTM systems are valid navigator action. This will go through all assigned rooms that are currently marked with an exclamation mark and attempt to correct them.

Note that the presence of the exclamation mark does not indicate that the model cannot be simulated – it simply indicates a problem with the HTM set-up in that room, which may result in inaccurate HTM simulation results.

**What happens when a room is assigned?**
The act of assigning a room to an HTM unit group makes a number of modifications to that room’s assigned data, internal gains, air exchanges and MacroFlo opening type, each with the intent of setting up the room for an accurate simulation of HTM.

The following modifications are made to the Room Data for the room:

- The **Heating Profile** will be set to **off continuously**.
- The **Heating Setpoint** will be set to **Timed and constant 0**.
- The **Cooling Profile** will be set to **off continuously**.
- The **Cooling Setpoint** will be set to **Timed and constant 0**.
- The **System Outside Air Supply Variation Profile** will be set to **off continuously**.
- The **Variation Profile** for any existing Natural and Auxiliary Ventilation air exchanges in the room will be set to **off continuously**.

In addition, the MacroFlo assignments for any associated external doors (louvres) and windows will be updated – see **Opening Type Updates** for details.
**What happens when a room is unassigned?**

The act of assigning a previously-assigned room to the *No HTM Assigned* unit group will result in the following modifications being made:

- **ALL** template-derived values for the room will be set back to *From Template*.
- The MacroFlo opening types assigned to the window(s) and door(s) attached to the unit will be reset back to their original opening type. If the original opening type is now unavailable, it will be set to the opening type specified by the room’s MacroFlo template.
- The construction for any door(s) attached to the unit will be reset back to their original construction. If the original construction is now unavailable, it will be set to the construction specified by the room’s construction template.
- Any automatically created profiles and MacroFlo opening types that are not in use will be removed from the model.

At this point, the room will no longer display the Monodraught logo and any associated openings will not appear highlighted.

**Editing HTM Opening Types**

If you wish to modify the assigned louvres and windows after a room has been assigned to a unit group (or if the *Automatically identify HTM® openings on room assignment* setting was not active), there are three options available:

- Change opening types individually via drop-down menu on the view when the *Monodraught HTM®* grouping scheme is active.
- Change opening types individually via right-click menu in the room browser when the *Monodraught HTM®* grouping scheme is active.
- Change opening type for one or more selected openings simultaneously using the *Opening Selection and Assignment* functionality in ModelIT.

**Changing Opening Type on the view**

When a room is assigned to an HTM unit group and the *Monodraught HTM®* grouping scheme is active, an overlay will be displayed at the top-right of all external windows and doors in the room – when zoomed in sufficiently, this opening will indicate the type of opening using an icon (if the opening is used by the HTM unit(s) in the room) or a drop-arrow (if the opening is not used by the HTM unit(s) or the viewport zoom is insufficient to display the icon):
The icon or drop-arrow acts as a hotspot for the opening, allowing you to access a drop-menu to change its type whenever the standard Select tool is active (indicated by ✧ on the toolbar) – the mouse cursor will change when over the hotspot (:pointer) to indicate that a menu can be displayed. You can then either left or right click on the hotspot to display the menu:

In the drop-menu, the current type of the opening is indicated in bold – you can select one of the other options to set the opening to function as that type. Note that if External Door/External Window is selected, the opening will no longer be associated with the HTM unit(s) in the room and its previous MacroFlo opening type (and construction, in the case of doors) will be restored (see Opening Type Updates for details).

Note that you can also display a balloon tip containing information on the opening and its type by hovering over its hotspot with the mouse cursor (rather than clicking):

As with the drop-menu, the balloon tip is only displayed when the Select tool (✧) is active.

**Changing Opening Type using the browser**

When the Monodraught HTM® grouping scheme is active, you can also use the browser’s right-click context menu to change the type of an opening. If you right-click on a wall-based external window or door item in the browser (note that you don’t have to left-click it first to select it), an additional HTM® Opening Type sub-menu will be displayed – this offers the same options as the hotspot drop-menu on the view for the opening:
As before, the current type of the opening is indicated in bold – you can select one of the other options to set the opening to function as that type. Note that if External Door/External Window is selected, the opening will no longer be associated with the HTM unit(s) in the room and its previous MacroFlo opening type (and construction, in the case of doors) will be restored.

The HTM® Opening Type sub-menu will not be displayed if you have right-clicked on an item that is not an external door/window, or if you have right-clicked on an external door/window in a room that is not assigned to an HTM unit group.

**Changing Opening Type using Opening Selection and Assignment**
The Opening Selection and Assignment functionality in ModelIT has been extended to allow it to additionally select by type and assign type to openings. This method allows you to quickly select openings by their type (in addition to other settings such as area, sill height and orientation), as well as quickly set the type for selected openings.

The Opening Selection and Assignment utility operates on external windows or external doors – it cannot select and apply across both types simultaneously, nor can it act upon internal openings. Before using it for a particular type, you can select an opening manually on the view to ensure the utility is in the correct mode (e.g. to select/assign to doors, click on a door in the view first).

**Note:** The Type options for select and assign will only be displayed if at least one room is assigned to an HTM unit group. If you have changed the room assignments whilst the utility is opened, you will need to close the Opening Selection and Assignment window and re-open it again in order to display the options.
In the case of selection, you can use the Type option in combination with the existing options to fine-tune which opening(s) will be selected. For example, select all HTM Integrated Louvres at an orientation of 90°:

![Select option](image)

In the case of assignment for HTM types, you should avoid using it in combination with the MacroFlo option (and, in the case of louvres, the Construction). This is because assigning the HTM types will also update the MacroFlo/Construction assignments of the openings, thus cancelling out your selected choices.

If you attempt to assign an HTM type onto a window/door in a room that is not assigned to an HTM unit, the type will be left as a standard window/door.

**Opening Type Updates**

In order to accurately model the airflow characteristics of the HTM units for thermal simulation, modifications are made to the assigned MacroFlo opening type for the opening (and, in the case of doors, a custom Monodraught Quantum Damper construction is assigned). These modifications are performed on a copy of the MacroFlo opening type, as the original may be applied to other openings in the model that are not attached to HTM. However, if a suitable copy of the MacroFlo opening type already exists in the model, this one will be used instead to avoid bloating the opening type database.

The exact nature of the modifications to MacroFlo are dependent upon the type being set on the window/door. For HTM® Integrated Louvre, the following modifications are performed:

- The **Opening Category** is set to Louvre.
- The **Openable Area %** is set to 100.
- The **Coeff. Discharge** is set to 0.12.
- The **Equivalent Orifice Area** is recalculated.
- The **Degree of Opening** profile is set to HTM Exhaust and Intake Louvre - Yearly.
- The **Description** is set to HTM® Integrated Louvre (it may be optionally suffixed by a number, should multiple opening types exist with this name).

For HTM® Exhaust Louvre, the following modifications are performed:

- The **Opening Category** is set to Louvre.
- The **Openable Area %** is set to 100.
- The Coeff. Discharge is set to 0.15.
- The Equivalent Orifice Area is recalculated.
- The Degree of Opening profile is set to HTM Exhaust and Intake Louvre - Yearly.
- The Description is set to HTM® Exhaust Louvre (it may be optionally suffixed by a number, should multiple opening types exist with this name).

For HTM® Natural Vent. Louvre, the following modifications are performed:

- The Opening Category is set to Louvre.
- The Openable Area % is set to 100.
- The Coeff. Discharge is set to 0.15.
- The Equivalent Orifice Area is recalculated.
- The Degree of Opening profile is set to HTM Exhaust and Intake Louvre - Yearly.
- The Description is set to HTM® Natural Vent. Louvre (it may be optionally suffixed by a number, should multiple opening types exist with this name).

For HTM® Natural Vent. Window, the following modifications are performed:

- The Opening Category is set to Window – top hung.
- The Openable Area % is set to 95.
- The Max Angle Open ° is set to 20.
- The Equivalent Orifice Area is recalculated.
- The Degree of Opening profile is set to HTM Window - Yearly.
- The Description is set to HTM® Natural Vent. Window (it may be optionally suffixed by a number, should multiple opening types exist with this name).

All other settings in the created MacroFlo opening type should use the same values as their original source opening type.

When an opening is changed back to External Door or External Window (either manually using the options detailed in the previous section, or by assigning the room to the No HTM Assigned group), the assigned MacroFlo opening type will be reset to its original state (i.e. prior to setting the HTM type of the opening). If the original MacroFlo opening type is no longer available, the opening type specified by the room’s MacroFlo template will be used. In the case of external doors, the construction will also be set back to its original state – if the original construction is no longer available, the construction specified by the room’s Construction template will be used.

**Note:** HTM MacroFlo opening types are automatically removed when they are no longer required – you are therefore prevented from manually assigning them onto openings. This limitation also applies to HTM Profiles, as they are automatically removed if all HTM unit groups (i.e. all HTM components in the component library) are removed from the model. Whilst it is possible to edit the values of the HTM MacroFlo openings and profiles, this is not recommended as it may result in inaccurate HTM simulation results that do not reflect real-world performance of the units.

**Simulating with HTM**

Once you have assigned the rooms in your model to HTM unit groups as appropriate, the model should be ready to simulate. The relevant Navigator actions will be enabled when you click the
checkbox to the right of the *Assign selected rooms to the appropriate HTM® system* action (acknowledging that you have completed the action).

In order to proceed to simulation, you should perform the *Ensure that all rooms assigned to HTM® systems are valid* action – this will attempt to correct any problems with the HTM data on any room that is marked with an exclamation mark.

If one or more rooms could not be corrected automatically, an alert should display at the bottom-right of the VE window indicating the number of rooms that need manual attention.

In this situation, you should review the problems for each invalid room by hovering the mouse over each room’s exclamation mark – you can then take appropriate action to resolve the issue and then retry this step. Once all assigned rooms are valid, clicking on action again should display the following alert at the bottom-right of the VE window:

![Alert: All rooms currently assigned to Monodraught HTM® systems are valid.](image)

You should then click the checkbox to the right of the *Ensure that all rooms assigned to HTM® systems are valid* action to enable the action for assigning HTM to an HVAC system file.

**Applying HTM to an ApacheHVAC system file**

In order to simulate HTM in your model using Apache, you **must** apply the HTM assignments to an ApacheHVAC system file (.asp) – this could be an existing HVAC system file that you already have set up for your building, or the VE can create you a new file that will represent just the HTM functionality. You then include the relevant .asp file in the simulation by selecting it as the active *ApacheHVAC Link?* file.

To apply your HTM assignments to an ApacheHVAC file, click on the *Apply HTM® assignments to ApacheHVAC system files* action in the navigator – the Apply HTM® to HVAC System(s) will appear:
You can choose to create a new .asp file containing the HTM assignments or apply the HTM assignments to one or more existing .asp files for your project.

To create a new .asp file containing the HTM assignments, click on the New HVAC system button and enter a unique name (excluding the .asp extension) for the new file. If the name is valid, a green tick (✓) will be displayed to the right of the text field – otherwise, it will display a red cross (✗). You can hover over the red cross for details on why the name cannot be used. When you click OK, the .asp file will be created with the name you entered.

To apply the HTM assignments onto one or more existing files, click on the Existing HVAC system(s) button and click the checkboxes next to the file(s) you want to add to. When you click OK, the file(s) you checked will be updated to include the HTM assignments. Note that the Existing HVAC system(s) button is only enabled if your project folder contains one or more .asp files. If you select a network file that has already had HTM previously applied, the HTM assignments will be updated to reflect the current set-up.

Simulate HTM performance using Apache
Once you have applied the HTM assignments to an ApacheHVAC system file, you are ready to perform a simulation. Clicking the Simulate System action under Thermal Simulation will switch to Apache view and prepare to run an Apache Simulation. In order to effectively simulate and view results for the HTM, the following simulation options are required:

- Enable SunCast Link? should be active
- MacroFlo Link? should be active
- ApacheHVAC Link? should be active, with an HVAC system file selected that has the current HTM assignments applied to it
- Auxiliary ventilation air exchange? should be active
- Natural ventilation air exchange? should be active

The Simulate System action will first check your current simulation options to see if they match these desired values – if not, a message will be displayed to indicate this:

You can use the Show Details button at the bottom-left to display information on which setting(s) are not at the expected value. If you would like the settings to be automatically updated to be optimal for simulating HTM, you can click the Update Simulation Options for HTM® button – otherwise, click the Use Existing Simulation Options button to continue with your current simulation options.
The standard Apache Simulation window should then appear, allowing you to configure which period you want the simulation to cover. Once ready, you can start the simulation by clicking the Simulate button.

Once completed, the VE should switch to VistaPro for viewing and analysing the results.

4. HTM and UK NCM analysis (Part L & EPCs)

The NCM framework
Then National Calculation Methodology (NCM) is the framework defined by the UK Government for the analysis of buildings and their systems for the purpose of analysis relating to Part L (for England, Wales and Northern Ireland), Section 6 (for Scotland), and Energy Performance Certificates (for all UK regions).

NCM analyses are governed by rules setting out the simulation methods to be used and the conditions applying in those simulations. Setpoints, occupancy, DHW consumption, internal gains and minimum ventilation rates are specified for a standardised set of building types and activities. Systems are organised into categories, infiltration rates are calculated by approved methods, and rules are laid down for the calculation of energy used by fans and pumps (‘auxiliary energy’). These rules mean that conditions and methods used within the NCM framework to simulate the Actual Building (a specialised NCM term) may differ from those applicable to the real building (the building as designed, occupied and operated).

Analysing the real building and the Actual Building
The preceding sections of this user guide describe the approach to analysing the real building, using simulation methods tailored to the detailed representation of systems.

In order to comply with the special requirements of NCM a modified approach is required. This involves analysis of the Actual Building and the buildings which the software derives automatically from it – the Notional Building and (for EPC purposes) the Reference Building. These analyses are performed in the VE Compliance view of the VE, where tools are provided to facilitate the input and editing of the additional data items.

Because some of the data required for NCM is shared with the analysis of the real building, NCM analysis should be conducted on a copy of the real building model modified to accommodate the NCM requirements.
In the VE Compliance view the Monodraught HTM units and logos are not displayed, and their place is taken by provisions compatible with the NCM rules. In this view, it is not possible to modify the assignment of rooms to unit groups. The Assign Room Group window will notify you when this is the case:

Fan heat gains from Monodraught HTM systems will be ignored in NCM analyses, which use standard prescriptions for room heat gains. The electricity consumption of the ventilation fans, must, however, be accounted for.

To represent Monodraught HTM systems working in combination with the systems providing heating (and where appropriate cooling) to the building, one or more Apache Systems must be created. The characteristics of these systems should be entered via the UK NCM system data wizard, starting with the selection of a suitable system type from the UK NCM system type menu. Adjustments should then be applied to cater for the unique features of the Monodraught HTM systems.

To cater for rooms for which a Monodraught HTM system supplements an air conditioning system, an Apache System should be created with an appropriate air conditioning system type, and in this case Changeover mixed mode free cooling on the Apache System Cooling tab should be set to Mechanical ventilation.

Close attention should be paid to the settings on the System adjustment, Metering Provision and System controls tabs of the UK NCM system data wizard, since these have a critical effect on performance as assessed by the Regulations.

When the Apache Systems have been created, they must be assigned as appropriate to each room served by a Monodraught HTM system. These assignments can be made (to the System field on the System tab) either in the Building Template Manager or in the room’s Space Data dialog.

On the System tab of the Room Data dialog for each room served by a Monodraught HTM system:

- **System and Auxiliary vent. system** should be set to the appropriate Apache System.
- **DHW system** should be set to the Apache System created for this purpose.
- **Free cooling flow capacity** should be set to the maximum volume flow rate that the Monodraught HTM system is able to deliver to the room.
- **Is there mechanical supply in this room?** (when present) should be ticked, and immediately below it the checkbox **Specific fan power** should be set according to the principles described below.
- **Demand controlled ventilation Type** should be set to Demand control based on occupancy density \((Cd = 0.85)\).

For heated-only rooms served by Monodraught HTM systems, **Cooling/vent.** on the Cooling tab should be set to Mechanical ventilation. In cases where the Monodraught HTM system provides all
the ventilation, the Air supply setting on the Ventilation tab of the UK NCM system data wizard should be set to Local ventilation-only units, such as window/wall/roof units serving a single area. The natural ventilation component of the system will be taken into account via SFP adjustments described below. It should be noted that the aspects of the system which provide benefit in the form of reduced summertime temperatures do not explicitly receive credit for this benefit under the current NCM Criterion 3 rules, which in contrast to earlier editions of the Regulations are expressed exclusively in terms of reduced solar gain. However, this aspect of performance will form an important part of the design as assessed by the performance of the real building.

Set up this way, the system will be assessed for regulatory purposes against a comparable system in the Notional Building.

Fan power used by a Monodraught HTM system is represented within the NCM framework as a component of auxiliary energy. This is the sum of contributions from pumps and fans. Pump power is a function of system category and subject to limited user control. Fans fall into two categories – central and local – for each of which a specific fan power (SFP) must be specified.

In the case of heating-only systems for which ventilation is provided locally the SFP parameter on the Apache System dialog (System specific fan power (SFP)) should be set to zero and a suitable SFP value entered on the System tab of the Room Data dialog for each room. This value should represent the average SFP applicable to the room ventilation during operating hours, accounting for the fact that for many hours the fan will be off. A suitable value (which will typically be very small) should be derived from detailed simulations performed (under equivalent assumptions) for the real building.

Where heating and cooling is supplied by a separate system providing mechanical air distribution there will be SFPs associated with the central system and/or the local air delivery. Where appropriate these SFPs should be modified to take account of the small additional fan power incurred by a Monodraught HTM system.

A separate Apache System, with suitable operation parameters, should be created to provide domestic hot water (DHW), and assigned to the rooms for this purpose.

For the model used for NCM analysis, infiltration is set using parameters on the Building & System Data dialog. MacroFlo analysis should be disabled by ensuring that the MacroFlo link? checkbox is unticked on the Simulation Settings tab of the Building & System Data dialog.

On the Simulations Settings tab of the Building & System Data dialog (accessed via the button Set Building & System Data at the bottom of the screen):

- SunCast link? should be ticked if a suitable shading file has been generated.
- MacroFlo link? should be unticked (in contrast to the setting in Apache View).
- HVAC link? should be unticked (in contrast to the setting in Apache View).
- Radiance link? should be unticked.
- Natural ventilation air exchange? should be unticked.

With regard to the numerous other data inputs relating to NCM presented in the VE Compliance view, reference should be made to the general guidance provided on this aspect of the software.
Appendix A:  Frequently Asked Questions

**Q:** Why are some actions on the Monodraught HTM® navigator greyed out?

**A:** If the action is greyed out but also has a small padlock icon shown on its checkbox ( ), this indicates that you do not have a suitable view license to carry out that action. See Requirements for using HTM in the Virtual Environment for more details on the licenses required to use the HTM integration within the VE.

If the padlock is not displayed but the action remains greyed out, this means the action requires you to tick one or more previous actions (therefore acknowledging that you have performed them) before you can carry out the action.

**Q:** I have a number of rooms contained in one HTM unit group. I want one of these rooms to use slightly different HTM properties (e.g. operation profile) to the others – how can I do this?

**A:** All rooms assigned to an HTM unit group will share the same HTM properties. If you want one or more of the rooms to use tweaked values, you must create a duplicate of the unit group, tweak the relevant values in that duplicate group, then re-assign the appropriate rooms to that duplicate group instead. See Duplicating Unit Groups for guidance on how to achieve this.

**Q:** Can I have different HTM units within the one room (e.g. an HTM FS unit and an HTM F unit)?

**A:** This is not currently possible – for modelling within the VE, a room can only be assigned to a single HTM unit group (and therefore a single unit type). It is advisable that is only done for rooms which can be separated into two independent rooms with a folding partition or such like. In this instance, it is recommended that the rooms are modelled as two separate rooms.

**Q:** Do I need to use the Monodraught HTM® navigator workflow to apply HTM to my model, or can I do it myself?

**A:** The navigator acts as a guide to best-practice and offers the most straightforward workflow for applying HTM to your model. However, you can import HTM components from the source library, assign rooms to the unit groups, set which openings are used by the HTM units and so on without using the navigator. The only step that specifically requires the use of the navigator is the Apply HTM® assignments to ApacheHVAC system files action, used to add the HTM assignments to an HVAC network file prior to simulation. It is recommended that you follow the navigator for convenience and practicality, unless you have a specific situation where you need to do otherwise.

**Q:** I have an external louvre that is a different size to those specified for the HTM system. Can I still use this or does this need to be changed?

**A:** The Monodraught HTM has the flexibility of working with slightly different sized louvres. We recommend that the louvre for the HTM F has a minimum area of 0.45m² and the HTM FS has a minimum area of 0.27m². In reality, a transition/spigot would be manufactured to match the louvre size and provide the connection to the HTM system. However, it is recommended that the louvre proportions are designed to match the HTM as closely as possible.
Q: **How do I utilize a cross ventilation strategy within a room assigned with HTM systems?**

A: Assign any additional external opening windows and/or louvres, as detailed within the earlier sections of this guide, either on the same elevation that the HTM units will be located, or to the opposite elevation of the room. For exhaust path that will be into another room, a door with a suitable air transfer profile will need to be created and assigned.

Q: **I would like to locate the HTM system on an internal wall to draw air in from a central atrium, but the Navigator only allows the system to be assigned to an external façade.**

A: The HTM system is designed to operate utilizing external air and should only be located on an external façade of a room. The design and comprehensive control strategy of the systems has been developed to allow wintertime air mixing/tempering to minimize any cold drafts and maintain a suitable minimum temperature of the supply air.

Q: **Does the simulation of HTM units take account of the optional heating coil for real-world HTM units?**

A: Although the prototype HVAC networks used in the VE to simulate HTM include a heater coil component, it is switched off by default – this is because Monodraught have indicated that it is not an option that is generally specified. Although not currently exposed through the VE user interface for HTM, you can modify an ASP in which you have applied HTM pre-simulation to account for the heating coil in the following manner:

- Follow the navigator in the normal manner through to the Apply HTM® assignments to ApacheHVAC system files action, applying to either an existing or new .ASP file.
- Switch to the ApacheHVAC module and open the .asp file.
- Open ApPro using the button on the toolbar.
- Select Weekly Profiles from the Pattern drop-down, then select the HTM In-Use Hours profile.
- Click the Copy button, then click Save before exiting ApPro.
- In the HVAC Components browser, navigate to HVAC Network->Airside->Controllers->Independent controllers with sensors and double-click on HTM Heater Battery Control - <9DegC. This controller is located immediately above the Heating Coil within an HTM F/FS prototype network:

![Image](htm-heater-battery-control.jpg)

- Change the Time Switch Profile for the controller to the HTM In-Use Hours profile copied above (in place of Off Continuously).
- Repeat for any other HTM F/FS prototype networks in the .asp.
- Save the .ASP file
- Return to ModelIT and continue with the navigator steps to simulate (ensuring that the .ASP you’ve been editing is selected for use when simulating).

These steps must be repeated if the Apply HTM® assignments to ApacheHVAC system files action is subsequently reapplied on a .ASP file you had previously modified.
Appendix B: HTM Technical Data

Louvre sizes and requirements for HTM systems
For the HTM systems to operate, they require at least one dedicated louvre on the external façade that would be connected to each HTM system. The louvre should generally match the overall size of the HTM system it is connecting to, however there is flexibility to also utilise alternative size louvre.

**HTM F system** – It is recommended that a louvre size of 900mm(w) x 500mm(h) is utilised. Should a different sized louvre be required, a minimum louvre area of 0.45m² should be achieved.

**HTM FS system** – It is recommended that a louvre size of 900mm(w) x 300mm(h) is utilised. Should a different sized louvre be required, a minimum louvre area of 0.27m² should be achieved.

Where additional natural ventilation louvres are being utilized within a room which has HTM systems assigned, there is no minimum or maximum sizes required. These can be sized to match other elements within the external façade of room.

**Recommended HTM system room configuration**
As there are many variations of room sizes and room usages, a guide of recommended system quantities for a few different room sizes and applications has been detailed below.

**Education**
- Standard Classroom (from approx. 55m², as long as width <11.0m or depth <9.0m)
  - 1 HTM F system or 2 HTM FS systems.
- Large Classroom (from approx. 100m² or when width >11.0m or depth >9.0m)
  - 2 HTM F systems or 3 HTM FS systems.
- IT Classroom (32N° Occ & PC’s) – 2 HTM F systems.
- Staff breakout, Group Rooms (approx. <30m²) – 1 HTM FS system.

**Other**
- Office areas – 1 HTM F system or 2 HTM FS systems per 20m².
- Staff breakout, Meeting Rooms (approx. <30m²) – 1 HTM FS system.
- 25N° people (at 10 l/s/p) – 1 HTM F system.
- 12N° people (at 10 l/s/p) – 1 HTM FS system.
Appendix C: About Monodraught Ltd.

Monodraught has been at the forefront of designing and manufacturing low energy, low carbon solutions for over 40 years. Our company is focused around three major product areas in which we are recognised as Market Leaders – Natural Daylight, Natural Ventilation, Natural Cooling and Hybrid Ventilation.

Supported by a great team of people, including Research and Development, Project Sales Engineers, Contract Engineers and directly employed Installation Teams, we have the Skills, Knowledge and Experience to take your project from initial concept stage through to final commissioning.

Monodraught is part of the VKR Holding which is a limited holding and investment company with the objective to create value through financial investments and ownership of companies that bring daylight, fresh air and a better environment into people’s everyday lives.

VKR has various foundations that provide funding for non-profit projects with scientific, cultural, artistic, and social objectives and support the employees of the VKR Group.

Contact Us:

Address: Monodraught Ltd
          Halifax House
          Cressex Business Park
          High Wycombe
          Buckinghamshire
          HP12 3SE
          United Kingdom

Telephone: +44 (0)1494 897700

E-mail: info@monodraught.com